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 

Abstract— The research work introduces a step by step 

tutorial to solve transportation problems by using an M.S. Excel 

solver add-on. This research is carried out based on the actual 

data of a transportation company. The studied transportation 

network includes ten sources and nineteen destinations. It was 

required to minimize the total ton-kilometers. The real data, the 

solution algorithm, the Excel solver tutorial, as well as the 

optimal solution, are included. 

 

Index Terms— Transportation Problem, Excel Solver, 

Transportation Problem Case Study, Minimizing 

Transportation Costs 

I. INTRODUCTION 

  With a company that owns more several sources to distribute 

its products to several destinations, the transportation 

problem plays a significant role in such companies. 

Transportation problem aims at finding the optimal 

distribution of goods from several sources to several 

destinations. The objective of the optimal distribution is to 

minimize both transportation cost, distance, and time. 

The transportation problem was founded by Gaspard Monge 

(1871) [1]. Then Tolstoi, A.N. started to study the 

transportation problem in the 1920s. F.L. Hitchcock (1941) 

[2] worked on the 

distribution of products from several sources to numerous 

localities. Koopman [3] worked on the optimum utilization of 

transportation systems and used a model of transportation, in 

activity analysis of production and allocation. It is known as 

Hitchcook Koopman transportation problem.   

Enormous advanced researches were prepared in 

transportation problem models. Kaur, L. et al [4] introduced a 

new approach to solving the multi-objective transportation 

problem. It is a simple approach to obtain the best 

compromise solution of linear multi-objective transportation 

problems directly. Afwat, M. et al [5] present a new method to 

solve multi-objective transportation problems called product 

approach. They use fuzzy programming to convert the 

objectives which have different units to membership value 

then aggregate them by product. This approach is an easy and 

fast method to find solutions close to the optimum solution. 

Al-Rajhi et al [6] prepared a decomposition algorithm for 

solving a class of bi-criteria multistage transportation 

problems. They presented the mathematical formulation of 

different bi-criteria multistage transportation problem and an  
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algorithm for solving a class of them. The studied class can be 

solved using the decomposition technique of linear 

programming. That was done by utilizing the special nature of 

the transportation problem. The method of finding the 

no-dominated extreme points in the criteria space. Ellaimony 

et al [7] solved a class of bi-criteria multistage transportation 

problems using dynamic programming techniques. Their 

algorithm is based on a dynamic programming technique with 

its capabilities to generate inherent parametric study during 

the solution. The technique is used to solve the bicriteria 

transportation problems. A method to find the non-dominated 

extreme points in the objective space is already developed. 

The dynamic programming technique is used to find the 

shortest route for transportation networks and methods for 

solving bicriteria linear programming. More other researches 

related to transportation problem are prepared for fuzzy 

transportation problem, interactive multi-objective 

transportation problem, and transshipment. Abdelati, M.H. 

[8] developed an interactive fuzzy multi-objective 

transportation problem approach. He applied his strategy to 

minimize both transportation time and fuel consumption 

through the non-productive kilometers between garages and 

the starting stations of Cairo Public Transportation Authority 

buses. He could reduce the studied objectives by 23% to 25% 

of the actual distribution. 

II. TRANSPORTATION PROBLEM MATHEMATICAL 

FORMULATION 

The mathematical model of the classical transportation 

problem is presented in most operations research and 

management science references such as Hillier, F. [9], Taha, 

H.A. [10], Lee, S.M. [11], Winston, W.L. [12], and more 

other references. The following equation represents the 

classical balanced transportation problem model. Balanced 

transportation problem exists when the total availabilities of 

sources equal the total requirements of destinations. 

 

 
Subject To: 

 

 

 
Where: 

Z: is the total transportation cost, time or ton-kilometers. 

Cij: are the unit costs of transportation. It could be money, 

time or distance. 
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Xij: are the amounts in tons that should be transported from 

source (i) to destination (j). 

ai: are the sources availabilities in tons. 

bj: are the destinations requirements in tons. 

m: the total number of sources. 

n: the total number of destinations. 

 

For balanced transportation problem, the total amounts of 

sources availabilities equals the total amounts of destinations 

requirements.   . 

III. EXCEL SOLVER FOR TRANSPORTATION 

PROBLEM 

To solve transportation problems usually requires three steps. 

These steps are as follows. First, finding the initial basic 

feasible solution. Then the test of optimality. Next, moving 

towards optimality. These steps can be applied to solve small 

examples of transportation problems. With examples of a 

large number of sources and destinations, the three steps need 

considerable effort and time to solve such problems. When 

considering real-world applications of transportation 

problems for real transportation companies, it will be 

complicated, close to impossible, to solve more significant 

problems. Excel solver can solve such big transportation 

problems easily and very fast with less effort. 

Excel solver is an add-on that exists in M.S. Excel. The solver 

is prepared in different versions with different limitations by 

Frontline Systems Inc. By Using Excel solver, we can easily 

find an optimal (maximum or minimum) solution for the 

objective function of an optimization model subject to its 

constraints on the values of other formula cells on a 

worksheet. 

Many researchers start to use excel solver to find the optimal 

solutions for their optimization problems. Vincent, E.O. [13] 

outlined the steps which are required for installing Excel  

Solver in Microsoft Word 2010 for use in solving linear 

programming problems. He applied excel solver to solve a 

transportation problem example. Vats, B.N. et al. [14] 

discussed and compared different models for solving 

transportation problems for finding an optimal method. All 

models have been compared with the Excel Solver technique 

for finding the best possible method. Ipsilandis, P.G. [15] 

examined an efficient approach in solving combinatorial 

programming problems with the use of spreadsheets. A 

practical application, which demonstrates the procedure, 

concerns the development of a spreadsheet-based DSS for the 

Multi-Item Procurement Problem with Fixed Vendor Cost. 

The DSS has been build using exclusively standard 

spreadsheet features and can solve real problems of 

substantial size. The benefits and limitations of this approach 

are also discussed. Çerkini, B. et al. [16] applied an excel 

solver to find minimal transportation cost. The problem is 

prepared as a linear programming model to minimize the total 

production and transportation cost. They added more 

constraints to the transportation problem based on their study 

work. 

IV. CASE STUDY COLLECTED DATA 

The data of a company located in Upper Egypt is studied in 

this research. They want to distribute their products which 

exist in 10 different cities to 19 other cities. The collected data 

includes all distances from all sources to all destinations in 

kilometers, the sources availabilities in tons, and the 

destinations requirements in tons. All data are prepared using 

M.S. Excel, as in the screenshot in Figure (1). In this Figure, 

cells C278 to U287 represent the distances between sources 

and destinations in kilometers. Cells V278 to V287 represents 

the availabilities of all ten sources in tons. Cells C288 to U288 

represents the requirements of all destinations in tons. 

 

 

 
Figure (1): Screenshot of the data collected table for the studied transportation problem. 

V. SOLUTION ALGORITHM 

Solving a transportation problem using an Excel solver can be 

done quickly using the following solution algorithm. 

 

 

1. Prepare two tables in Microsoft Excel, as in Figure (2) 

below. The upper one is the “Data Table,” which contains the 

unit costs from all sources to all destinations. The lower one is  
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the “Results Table.” It is empty to be filled by an excel solver. 

The results table will contain the optimal solution for the 

transportation problem. In the screenshot below, the unit costs 

at the data table exists at cells from (C278) to (U287), while 

the results table exists at cells from (C293) to (U302). 

 
Figure (2): Screenshot of the prepared tables for Excel solver. 

 

2. Prepare two one-row tables, as shown in Table (1). The 

upper of them should be filled by the Excel solver by 

calculating the summation of distributed products at each 

destination. The lower of them should contain all destinations 

requirements. This way, the Excel solver will compare the 

summation at the upper to the fixed values at the lower 

one-row Table. In the screenshot below, the upper one-row 

Table exists at cells (C304) to cell (U304), while the lower 

one-row Table exists at cells (C306) to (U306). 

 

3. The same upper procedures are carried out for sources. So, 

on the right side of the results table in step (5.1), prepare two 

one-column Tables. The left of them should be filled by the 

Excel solver by calculating the summation of distributed 

products at each source. The right table should be fixed, 

which includes all sources' availabilities. This way, the Excel 

solver will compare the summation at the left one-column 

table to the set values at the right one. In the screenshot below, 

the left one-column table exists at cell (W293) to cell (W302),  

while the right one-column table exists from cell (Y293) to 

cell (Y302) 

Table (1): All formulas that needed for the one-row,  

one-column tables and the objective function cell. 

  Cell Formula 

One-row table for 

destinations 

C304 0 

D304 0 

. . 

. . 

. . 

U304 0 

One-column table for 

sources 

W293 0 

W294 0 

. . 

. . 

. . 

W302 0 

Objective function cell Y309 0 
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4. Prepare just one cell to calculate the total transportation 

cost, or total ton-kilometers according to your problem 

objective function. This cell could exist anywhere in your 

spreadsheet. But we preferred to put it in the intersection of 

the fixed row in step (2) and the fixed column at step (3). i.e., 

cell (Y306). 

 

5. In each cell of the non-fixed one-row Table that was 

created in step (2), i.e., table with cells (C307 to U307) in the 

screenshot below, ask M.S. Excel to calculate the summation 

of all amounts that were distributed by Excel solver for each 

destination. We do this by adding formulas at each cell of this 

non-fixed one-row Table. All formulas of these cells are 

illustrated in Table (1). 

 

6. In each cell of the non-fixed one-column Table that was 

created in step (3), i.e., table with cells (W293 to W302) in the 

screenshot below, ask M.S. Excel to calculate the summation 

of all amounts that were distributed by Excel solver for each 

source. We do this by adding formulas at each cell of this 

non-fixed one-column Table. Again, all formulas of these 

cells are illustrated in Table (1). 

 

7. In the objective function cell, i.e., cell (Y306), calculate the 

total cost or total ton-kilometers by multiplying all unit costs 

in the data table by all amounts that were distributed by excel 

solver in the results table. The formula of this cell is illustrated 

in Table (1). 

 

8. Make sure that the Excel solver is activated in your M.S. 

Excel. The “Solver” icon exists under the “Data” menu in 

M.S. Excel. If the solver icon is not there on your Excel, you 

can activate it under: File => Option => Add-Ins => Solver 

Add-in => OK, as shown in screenshot in Figure (3) 

 

 
Figure (3): Screenshot for activating M.S. Excel solver 

 

9. Now start the Excel solver. Under the “Data” menu, at the 

most right, the “Solver” icon should exist. By clicking the 

solver icon, the solver parameters pop up window appears. 

There are some parameters here that need to be adjusted as in 

the following steps more details in Figure (4). 

 

 
Figure (4): M.S. Excel Solver Pop Up Windows 

 

10. On the set objective field, we write the cell 

location, which we calculate the total transportation cost. It is 

cell (Y306) in our case study in this paper. 

11. To minimize or maximize according to your 

problem objective function. In our case study, we choose Min. 

12. By changing variable costs: These should be the 

cell where the values of Xij should exist. These are cells from 

(C293) to (U302) in this case study. 

13. Subject to constraints. Here we should have four 

sets of constraints according to our case study. Note that the 

cell numbers may differ according to your data in the excel 

sheet. 

(a) A set of constraints to tell excel solver that we 

need the decision variables to be integers. In our case study, 

this set is:  

C293:U302 = Integer. 

(b) A set of constraints to tell excel solver that we 

need the decision variables to be greater than or equal zero. In 

our case study, this set is: C293:U302 ≥ 0. 

(c) A set of constraints to tell excel solver that the 

total amounts that are shipped from any source must equal the 

availability of this source. In our case study, this set is: 

W293:W302 = Y293:Y302. 

(d) A set of constraints to tell excel solver that the 

total amounts that are shipped to any destination must equal 

the requirements of this destination. In our case study, this set 

is: C304:U304 = C306:U306. 

 

14. Choose Simplex LP. 

 

15. Click Solve button. 

16. The problem solution, as well as the total 

transportation cost, will appear in their appropriate prepared 

cells. 
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VI. CASE STUDY RESULTS 

Table (2) below summarizes the solution of the case study. It 

was found that the total ton-kilometers equals 684,334 for the 

studied month. The total ton-kilometers of the actual 

distribution in the same month was 932,572. The optimal 

distribution could reduce the total ton-kilometers by a 

percentage of 26.62% of the actual ton-kilometers. 

Table (2): Optimal Distribution of Products. 

VII. CONCLUSION 

M.S. Excel solver add-on is one of the best tools to solve 

transportation problem case studies. A step by step tutorial for 

solving a transportation problem by using excel solver is 

included. The optimal solution that was generated could 

reduce the total ton-kilometers for a particular month by a 

percentage of 26.62% of the actual ton-kilometers. 
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Xi,j Amount Xi,j Amount Xi,j Amount Xi,j Amount 

X1,1 

X3,1 

X4,5 

X6,7 

X7,1

9 

X9,1

1 

X10,

9 

552 

151 

357 

1128 

572 

239 

1284 

X1,2 

X3,3 

X4,6 

X6,8 

X8,11 

X9,14 

X10,1

0 

911 

822 

572 

99 

663 

1214 

1346 

X2,1 

X34 

X5,17 

X6,18 

X8,12 

X9,15 

X10,1

1 

689 

635 

2049 

472 

540 

1063 

155 

X2,16 

X3,5 

X5,18 

X7,8 

X8,13 

X9,16 

X10,1

9 

151 

531 

1387 

818 

386 

175 

151 


